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DEFINITIONS I
IDA publishes the following documents to report the results of Its work.

Reports I
Reports are the most authoritative and most carefully considered products IDA publishes.
They normally embody results of major projects which (a) have a direct bearing on
decisions affecting major programs, (b) address issues of significant concern to the
Executive Branch, the Congress and/or the public, or (c) address issues that have
significant economic implications. IDA Reports are reviewed by outside panels of experts
to ensure their high quality and relevance to the problems studied, and they are released

by the President of IDA.

Group Reports

Group Reports record the findings and results of IDA established working groups and
panels composed of senior individuals addressing major issues which otherwise would be
the subject of an IDA Report. IDA Group Reports are reviewed by the senior individuals
responsible for the project and others as selected by IDA to ensure their high quality and
relevance to the problems studied, and are released by the President of IDA.

Papers
Papers, also authoritative and carefully considered products of IDA, address studies that
are narrower in scope than those covered in Reports. IDA Papers are reviewed to ensure
that they meet the high standards expected of refereed papers in professional journals or
formal Agency reports.

i
Documents
IDA Documents are used for the convenience of the sponsors or the analysts (a) to record
substantive work done in quick reaction studies, (b) to record the proceedings of I
conferences and meetings, (c) to make available preliminary and tentative results of
analyses, (d) to record data developed in the course of an investigation, or (e) to forward
information that is essentially unanalyzed and unevaluated. The review of IDA Documents
is suited to their content and intended use.

The work reported in this document was conducted under contract MDA 903 89 C 0003 for
the Dcyann ent of Defense. The publication of this IDA document does not Indicate i

endorsement by the Department of Defense, nor should the contents be construed as
reflecting the official position of that Agency.

Approved for public release; distribution unlimited.
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PREFACEI
This document was prepared by the Institute for Defense Analyses (IDA) for3 the Defense Advanced Research Projects Agency (DARPA), under contract MDA

903 89 C 0003, Task Order T-A-144, issued 16 June 1990, and amendment. The

objective of the task was to develop practical ways to model and measure increases

in productivity, reductions in total lifecycle costs, and effects on quality of the

Department of Defense (DoD) Software Technology Plan (SWTP). The model

presented here was used to calculate the cost and savings of various software
technologies outlined in the SWTP and forms the basis of Chapter 10, "Return-on-

3 Investment," of the SWTP.

This work was reviewed within IDA by Michael C. Frieders and Stanley A.1Horowitz. Barry Boehm, the lead author of this document, is the Director of the

Information Systems Technology Office at DARPA.I
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I. INTRODUCTIONI
The Institute for Defense Analyses (IDA) developed a model to support3 analyses of the impact of improvements in software technology on total Department

of Defense (DoD) software development and maintenance costs. The model, called
the Software Technology Economic Impact Model, displays the cost savings
resulting from three major sources. The sources are 'vork avoidance" through
software reuse improvements, "working smarter" through process improvements,

and "vorking faster" through improvements in the tool environment.' These cost

savings are calculated for both development and maintenance from the years 1992

through 2008.

This software technology analysis has been automated by IDA through the
use of Microsoft Excel2 programming. The resulting model provides a set of pull-
down menus that allow a user to rapidly change a number of assumptions underlying

I the analysis and obtain graphical output of the resulting savings. A primary motive
for automating this model is to encourage exploration of alternative scenarios,3providing the user better understanding of the potential cost savings from various

software technology initiatives.

I The remainder of this section provides a description of the general logic of

the analysis. Included are a basic description of the model's structure, a list of theI
i The model was originally developed to analyze options for and to assess the impact of the Defense

Advanced Research Projects Agency (DARPA) program for Software Technology for Adaptable,
Reliable Systems (STARS), which is focused on the areas of software reuse, process, and
environments. The model has subsequently been found to be equally useful in assessing more
general software technology impacts, and is currently being used to support the development of the
DoD Software Technology Plan (SWTP).

"The purpose of the DoD Software Technology Plan is to define and justify a program of
coordinated DoD software science and technology activities and investments. The objectives of the
SWTP are, by the year 2000, to: reduce software costs by a factor of 2, reduce software problem
rates by a factor of 10, and significantly expand DoD capabilities via software." (Director of
Defense Research and Engineering, "Proposed DoD Software i echnology Plan," Draft, July 1991,
p. 1-1.)3 2 Microsoft Excel is a registered trademark of the Microsoft Corporation.

U
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required input parameters, and a brief description of the way the model calculates I
potential savings. The rest of the manual provides step-by-step instructions in both

written and pictorial form on how the model is used.

A. MODEL STRUCTURE AND PARAMETERS 3
The model structure allows comparison of a "baseline" scenario to a scenario

that adjusts this baseline by estimates of the effects of the SWTP. The baseline 3
includes estimates of DoD software expenditure in 1992, the distribution of this
expenditure between development and maintenance, and expenditure growth rates 5
over time. The effect of the SWTP is to adjust the original baseline by annual
estimates of the cost saving effects of work avoidance, working smarter, and working
faster.

The model displays the scenarios in total, by source of saving, and by stage in £
the software lifecycle. The model allows the user to enter estimates of the
investment required to produce the cost savings, and displays the net present value

of the savings and the return on investment (ROI).

The model provides a file with default values for both the baseline and

SWTP scenarios. All default parameter estimates in the baseline are generated
from single values. The SWTP estimates are entered year by year from 1992 to
2008. All baseline parameters and default values are shown in Table 1. The
bibliography section documents the sources of the default parameter estimates.

Table 1. Baseline Parameters and Default Values

Parameter Category Parameter Value I
Baseline

Total DoD 1992 software spending $24 billion 3
Development/maintenance split 30% development, 70% maintenance

Growth rates

Demand growth 9%

Productivity growth 4%

Inflation rate 5%

The model identifies three sources of cost savings due to software technology I
improvements. Table 2 shows the notation used to identify these savings sources.

21
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IThroughout this document, the formal name and characteristics are used

interchangeably. For example, EPCA and Reuse are both used to mean savings

from the reuse of code.

I Table 2. Savings Sources

Source Formal Name Characteristic

Work avoidance End Product Cost Avoidance (EPCA) Reuse

Working smarter Process Cost Avoidance (PCA) Process maturity

Working faster Process Cost Reduction (PCR) Tools and Software Engineering
Environments (SEEs)

EPCA occurs by reusing software through code libraries, commercial off-the-

shelf (COTS) software, generics, and any other product-related improvements.
PCA corresponds to savings due to process-related improvements such as those

captured by the Software Engineering Institute (SEI) process maturity assessment.

PCR results from improvements in Software Engineering Environments (SEEs),
frameworks, and better, more interoperable tools that partially automate software3 development and maintenance.

The model is divided into a development and a maintenance portion. The3l actual cost savings due to each of the three sources is determined by the assumed

fraction of savings and by the fraction of time these savings are realized. The

I components of savings are described in more detail in Section V.

I B. CALCULATING DEVELOPMENT SAVINGS

The model estimates the savings resulting from software technology3 improvements for the years 1992 to 2008. For each saving source and year, the user
may enter a fraction of savings (FS) from use of technologies as well as a fraction of

time (FT) for the fraction of projects on which any given technology is used. The

proportion of cost avoidance per source in a given year is the product of FS and FT.
That product subtracted from 1 is the residual cost fraction (RCF), which is the
fraction of costs left after the technology improvements have been applied. The
RCF multiplied by the annual baseline cost gives the annual cost under a software

I technology improvement program.

The following example shows the calculation of development savings.

!3
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Given that:

EPCA FS = 20%
EPCA FT = 10%

Baseline development = $5 billion for one year,
then: 3

RCF = 1 - (0.20 x 0.10) = 0.98

Baseline development = $5 billion x 0.98 = $4.9 billion with EPCA 3
improvements or $0.10 billion savings.

If the FT and FS foi PCA and PCR are the same as for EPCA, the savings would I
increase:

Baseline de'-,elopment = $4.9 billion x 0.98 = $4.8 billion with PCA I
improvements

Baseline development = $4.8 billion x 0.98 = $4.7 billion with PCR

improvements.
Use of all three improvements, EPCA, PCA, and PCR, would result in $0.3 ($5.0-
$4.7) billion in savings, compared to the unimproved baseline.

An improved baseline case has been defined where the FS and FT for each
of the three sources of development savings change over time. The model
developed by IDA allows you to change any of these values and observe the effect
on savings. The SWTP parameters and default values for the FTs and FSs are I
shown in Table 3. I
C. CALCULATING MAINTENANCE SAVINGS

The model also estimates the savings for maintenance resulting from I
software technology improvements for the years 1992 to 2008. For each year,
fraction of savings and fraction of time are calculated for each of the three sources. 3
Each source is made up of the following savings areas:

o EPCA: (1) use of COTS and (2) megaprogramming technology (Ada I
generics, domain-specific software architecture, module composition
technology, application generators).

o PCA: (1) improved maintenance process and (2) improved I
understandability of software.

o PCR: (1) increased use of tools and environments and (2) better I
structured, easy-to-modify software.

4



ITable 3. Software Technology Plan Parameters and Default Values

Development Maintenance

Reuse Process SEEs Reuse Process SEEs

Year FT FS FT FS FF FS FT FS FT FS FT FS

1992 0.005 0.700 0.050 0.120 0.150 0.020 0.020 0.700 0.050 0.100 0.100 0.010
1993 0.013 0.725 0.150 0.130 0.250 0.030 0.046 0.725 0.125 0.105 0.200 0.020
1994 0.020 0.750 0.250 0.140 0.350 0.040 0.071 0.750 0.200 0.110 0.300 0.030
1995 0.040 0.765 0.375 0.150 0.425 0.055 0.096 0.765 0.300 0.120 0-375 0.045
1996 0.060 0.780 0.500 0.160 0.500 0.070 0.120 0.780 0.400 0.130 0.450 0.060
1997 0.090 0.790 0.575 0.180 0.575 0.090 0.150 0.790 0.475 0.145 0.525 0.075

1998 0.120 0.800 0.650 0.200 0.650 0.110 0.180 0.800 0.550 0.160 0.600 0.090
1999 0.160 0.810 0.700 0.220 0.700 0.130 0.215 0.805 0.600 0.180 0.650 0.110
2000 0.200 0.820 0.750 0.240 0.750 0.150 0.250 0.810 0.650 0.200 0.700 0.130
2001 0.250 0.830 0.775 0.255 0.775 0.165 0.285 0.815 0.675 0.225 0.725 0.150
2002 0.300 0.840 0.800 0.270 0.800 0.180 0.320 0.820 0.700 0.250 0.750 0.170£ 2003 0.350 0.850 0.825 0.285 0.825 0.195 0.360 0.825 0.725 0.275 0.775 0.190
2004 0.400 0.860 0.850 0.300 0.850 0.210 0.400 0.830 0.750 0.300 0.800 0.210
2005 0.435 0.865 0.870 0.310 0.870 0.220 0.440 0.835 0.775 0325 0.820 0.225
2006 0.470 0.870 0.890 0.320 0.890 0.230 0.480 0.840 0.800 0350 0.840 0.240
2007 0.495 0.875 0.905 0.330 0.905 0.240 0.520 0.845 0.820 0.375 0.855 0.255
2008 0.520 0.880 0.920 0.340 0.920 0.250 0.560 0.850 0.840 0.400 0.870 0.270

Notes: Fr is the fraction of projects developed using these technologies and FS is the average savings resulting from using
a given technology.

IThe improved maintenance cost is calculated in the same way as the

i development cost. These values can also be changed within the model.

D. Calculating Return on Investment (ROI) and Net Present Value (NPV)

I To achieve the software development and maintenance cost savings

discussed above, a substantial investment by the DoD would be required. To assess

3the potential worth of such investments, two financial measures of merit are

computed. One measure is the ROI. The other measure is NPV. Both measures

I are calculated from constant dollars and account for time value of money by

"discounting" the benefits (in this case the DoD cost savings) and the costs (i.e., the

I DoD investment). 3

1 Constant dollars are used so that, after adjusting for inflation, a dollar in the future has the same
purchasing power as a dollar in the present. Discounted dollars are used so that, after discounting,3 a future dollar has the same value to us now as does a dollar in the present.
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The formula used in the NPV computation can be shown as: IM!
NPV = (1+d)t

where 
t=O

= the cost savings for year t, £
Ct = the dollar value of the investment in year t,

d = the discount rate,

m = the number of years over which the calculations are made. 5
For example, m = 16 and t = 0 corresponds to the year 1992.

To be consistent with Office of Management and Budget (OMB) guidelines, 5
we assume the discount rate to be 10 percent. The resulting NPV figure is the
present value (or worth today) of the stream of savings derived from the stream of

investments made oV.,r the period of the analysis.

The ROI computation is closely related to the NPV figure. The ROI 3
measure is the ratio of the discounted savings to the discounted costs. Algebraically

this can be shown as: 3
m St

t=O

E (1+d)t
t=O m

where the variables are defined as for NPV.

The ROI figure used in this analysis is interpreted as the return for a dollar I
of investment when adjusted for price level changes and the time value of money.
For example, if the ROI is computed to be 6, then for every constant, time- 5
discounted dollar invested by the government, 6 constant, time-discounted dollars in

savings will be returned. I

6
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II. GETTING STARTEDI
The model runs on the IBM PC4 and compatibles and on the Apple3 Macintosh.5 Either system must have a copy of Microsoft Excel, Version 3.0. It is

assumed that the user is familiar with pull-down menus, dialog boxes, and the use of
j a mouse.

A. INSTALLING THE MODEL

To install the Software Technology Economic Impact Model, copy all files

from the disk into a single directory or folder, preferably on the drive that contains
Excel. To access the model, open Excel, pull down the File menu and select the
Open option. Select the directory where the model is located, and double-click on
SOFTITECH.XLM.

B. MODEL OVERVIEW

The model has two main sections. The first concerns the analysis of the3 effects of various technology changes on existing DoD software spending
parameters. Using options from the Baseline, Development, and Maintenance pull-3 down menus, the user examines and changes the parameters that describe costs and
possible cost avoidance over the software lifecycle. The Edit pull-down menu is3used to help with data entry.

The second section of the model involves file and display management. The
pull-down menus View and Print implement displays and the results of data changes.

File management functions are performed under the File menu. The purpose of the
Help menu is to provide on-line help for all the other parts of the model. A
schematic of the model's menu bar and pull-down menus is shown in Figure 1.

4 IBM PC is a registered trademark of the IBM Corporation.3 5 Apple Macintosh is a registered trademark of the Apple Corporation.

I7
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Figure 1. Model Menus3

C. STARTING THE MODEL3

After opening the Software Technology Economic Impact Model, the title
screen (Figure 2) appears. When you first open the model, the only active items onI
the menu bar are File and Help. The Help menu is always available to the user as
an on-line reference for model operation. The commands available under the File3
menu are Open Case and Exit. If you select File/Exit, you will exit the model and
return to the operating system. If you select File/Open Case, the dialog box in3
Figure 3 appears. The dialog box allows you to choose the default file
(DEFAULT.STR) or any other file previously saved. On the PC, only files with theI
extension S5TR will appear in the dialog box. On the Macintosh, choose only files
with an S5TR extension. Double click on the chosen file to open it.3

Once you have opened a file, a chart showing totals by lifecycle appears
(Figure 4). The top two lines of the graph show the total DoD software

expenditures without and with the software technology initiative. The remaining
lines represent maintenance costs and development costs. The table below theg
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I chart shows the savings (difference between costs without and with the software

technology improvements) at two-year intervals. From this point, you may access

different views of the data and change the default values, as explained in the
following sections.

Help

I Software Technology Economic /

Impact Model
'II

~Version 2.0

3 Figure 2. Title Screen

1 Microot Exel
FN. Help

Sol 0 - "-O I nic

Figure 3: Opening a File

I
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III. VIEWI
The View pull-down menu provides access to graphical and numerical views5 of the data as well as the choice of current or constant 1992 dollars (Figure 5).

File Edk Bselses Develotpaeml Maelnme Pied Help

roastsat 1 992 Dellars

d ,/Telele by source Chai

M abec Cheat

..,ToalOs by Lftcycl C;be L

0 Full Speadeshee
Full Flas ocial S ?mmsey

I0 - -------------

mt ot by Suc a a wel a
Ded T~e l"O 4 "is MIN G111 UK 300

74W Is 14 4 t 33 1&7 4.1 UL)

3 Figure 5. View Pull-Down Menu

5 Graphical views include two total cost charts, a development chart, and a
maintenance chart. The Totals by Lifecycle chart is broken out by development and
maintenance (Figure 6). The Totals by Source chart, as well as the Development
and Maintenance charts, is broken out by Reuse, Process, and SEEs (Figures 7, 8,
and 9). A summary of cost savings is presented below each chart.

In addition to the graphs, two numerical views of the data are available. One
is Full Spreadsheet, which provides a view of the actual spreadsheet that generates

the spending and savings estimates. You may move around through the entire
spreadsheet underlying the model. This spreadsheet may be viewed but not
changed directly. The other numerical view is the Full Financial Summary (Figure
10). This view shows the NPV of all the savings, and the ROI. The computation of3 these two measures is detailed in Section I of this guide.

I
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The financial summary displays the investment costs entered in the SoftwareI
Technology Plan budget line and the cost savings generated by the model. At this
time, investment costs are designated at $1 million as a placeholder. See Section3
IV.D. for an explanation.) For this reason, the NPV and ROT are also placeholders.
The net present value measure combines the costs and cost savings of the SW17P3
and brings the resulting "net" to a 1992 "present value" by use of a 10% discount
rate. The present value approach allows comparisons of different streams of costs

and cost savings flowing from alternative SWTP policies. How to change the
amount of investment is discussed in Section IV. This financial summary display can
also be used as a summary indicator of the overall effects of large numbers ofI
changes to Reuse, Process, and SEEs.
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IV. MODIFYING THE BASELINE PARAMETERS

Baseline parameters relate to basic assumptions about DoD spending,5 including the total software costs, the proportion of dollars split between

development and maintenance, the rate of cost growth, the amount of investment in

I new technologies, and the expected rate of inflation. All of these parameters may
be modified by using the options under the Baseline menu, as explained in theg following subsections.

A. TOTAL DOD COSTS

I After you select Baseline/Total DoD Cost, the dialog box shown in Figure 11

appears. You may change the total DoD cost from the baseline default value of $243 billion (1992 constant dollars). This start value is automatically modified over time
through the Baseline/Growth Rates option. The graph and the savings values are3 recomputed to reflect the new total.
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Figure 11. Total DoD Cost Dialog Box

15



I _

B. DEVELOPMENT/MAINTENANCE SPLIT I
You may also change the proportion of total DoD spending that is spent on

development versus maintenance. The default values are 30% for development and
70% for maintenance (Figure 12). To change this proportion, select

Development/Maintenance from the Baseline menu and type in the maintenance

percentage (without the % sign). The development percentage will be
automatically computed. 3
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Figure 12. Development/Maintenance Value Entry Screen

When you choose the Development/Maintenance option, only the File, Edit,I
and Help menus remain active on the menu bar. File/Edit allows you to leave the

model at any time. The Edit menu has three options when
Development/Maintenance has been chosen: Close Window, Calculate Now, and
Align. Close Window calculates any changes and closes the open window, in this U
case, the Development/Maintenance window. Calculate Now shows the correct
development percentage without closing the window. Align brings you back to the 3
"home" position, should you get lost in the spreadsheet.

C. GROWTH RATES

The model allows changes to the growth rate for total DoD costs by choosing 3
the Baseline/Growth Rates option (Figure 13).
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M lcrosota Excel -Is
File Edit Boaselne Develpment Maeintenance View Print Help

Ivu DOD Salft.w Cob Sinesfawned DA-,)
um Sdt-a Teledtaf "Ma hoitin,

I _ _, Iv

I admre3

--.
G...... Raes

Tidd ta 20 4? 5 its 283 ? 245 31-3 NI
D ulme I 1.5 1.i 21 42 U I ? IS 112

________04te.~c 83 IS 33 55 52 121 12 I ZS$I
1 The net growth rate is determined by the difference between tie yearly

I percentage increase in demand and the yearly percentage increase in productivity

that are assumed will occur independently of the DoD Software Technology Plan.
i The growth rate equals the percentage increase in productivity less the percentage

increase in demand. For the baseline case, demand is assumed to increase at a rate
of 9% while the annual productivity increase without the SWTP is assumed to be14%. This results in a net growth in costs of 5%. To move between the two growth

rates in the dialog box, press the Tab key or use the mouse to point and click on the

I value you want to change.

Unlike the usual compounded growth, the net growth is calculated from the
I original total DoD cost. That is, with a net growth of 5% per year and 1992 total

cost of $24 billion, total spending in constant dollars for 1993, 1994, and 1995 is

3$25.2 billion, $26.4 billion, and $27.6 billion, respectively. With compounding, these

spending amounts would be $25.2 billion, $26.5 billion and $27.8 billion,3 respectively.

D. INVESTMENT

IAchieving cost savingesere investment in new software technologies.

Choosete iBaseline/Investment option to view or change the investment defaults.

t The DoD Software Technology Plan details several investment scenarios that the

DoD might pursue. Until the plan is officially released, however, the investment

I
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levels must remain confidential. As a place holder, the investment default valuesI

are set at $1 million per year.

E. INFLATION INDICES

The model allows changes in the inflation indices used to "deflate"' futureU
values of savings and investment. Choose the Baseline/Inflation Indices option to

change and view the indices (Figure 14). The default inflation indices assume 5%1
inflation per year.
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V. MODIFYING THE DEVELOPMENT AND3 MAINTENANCE PARAMETERS

3 Both the Development and Maintenance menus have three options that
represent the three parameters that may be changed: End Product Cost Avoidance5 (Reuse), Process Cost Avoidance (Process), and Process Cost Reduction (SEEs).

Figure 15 shows the Development menu as an example.
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IFigure 15. Development Pull-Down Menu

3 Each of the parameters for Development and Maintenance is changed in the

same way. We use the Development/End Product Cost Avoidance (Reuse) option3 as an example (Figure 16) here. You may change any of the values listed under the
"Fraction of Savings" or "Fraction of Time" columns. Select a cell, type a new value,1 and press either the Return or the Enter key. As stated in Section IV, the overall

proportion of savings is the product of the fraction of time and the fraction of

savings. For published sources of these and alternative time and savings estimates,

see the bibliography at the back of this guide.
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I

leave the model at any time. The Edit menu offers four choices: Close Window,
Calculate Now, Align, and Cancel (Figure 17). Close Window calculates any
changes and close the open window. Calculate Now calculates the effects of theI
changes, which will show up in the background graph without closing the window.
Align brings you back to the "home" position, should you get "loste in the
spreadsheet. Cancel erases any entries you have made and replaces them with the
values present when the window was first opened.I

The remaining options under the Development and Maintenance menus are
analogous to the Development/End Product Cost Avoidance (Reuse) example used3

here, and changes can be made in the same way.

I
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VI. FILE MANAGEMENTI
This section explains the menus and options used to save and close files, exit

5 the model, print results, and access help.

3 A. FILE

The File menu allows the user to open, save, and close files as well as exit the
I model.

1. Open Case

Open Case allows you to retrieve a case that was previously saved, or the
original case with the default values, DEFAULT.STR. All cases will have the
extension .STR. On the PC, only files with the .STR extension will appear.
Macintosh users should be careful to open only those files with an .STR extension.

2. Close Case

3 This options allow you to close the current case, but remain in the model. It
gives you the option of saving the case, if any changes have been made. Once the3 case is closed, you may open another case.

3 3. Save Case

When you are finished entering savings estimates, you may save your resultsIby selecting Save Case. You will be asked to supply a name for the case you are
saving. The file name is limited to eight characters for the IBM PC and
compatibles, as shown in Figure 18. Do not put the extension .STR on the file

name; it is automatically attached. Do no save the file as DEFAULT or the original
default values will be overwritten. If DEFAULT.STR is accidently overwritten,
copy DEFAULT.BAK to DEFAULT.STR. DEFAULT.BAIK can be found in you
model directory or folder, or on the original diskette.

I
I
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Figure 18. Saving a File

4. Exit 1
When you are ready to leave the program, select the Exit option from the i

File menu. The Exit option returns you to the operating system or desktop. If

changes were made during your use of the model, you will be asked if you want to 3
save the current case.

B. EDIT I
The Edit menu assists you in maneuvering around the spreadsheet and

through the model and in calculating changes to the default values (see Figure 17 in

the previous section).

When a window has been opened to change values, the other Edit options U
become available: Calculate Now, Close Window, and Cancel. Close Window

calculates any changes and closes the open window. Calculate Now calculates the
effects of the changes, which shows up in the background graph, without closing the

window. Align brings you back to the "home" position, should you get "lost" in the 5
spreadsheet. Cancel erases any entries you have made and replaces them with the

values present when the window was first opened. 3
C. PRINT

The Print menu options are shown in Figure 19. If you choose All, each

chart is printed along with its savings table. Also included are options for printing 3
241



I individual charts and certain combinations of charts. For example, the Development

Windows and Maintenance Windows options each print all three savings sources.U T'he model also has a Printer Setup option available to PC users. It accesses the
Windows Printer Setup facility.
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3 Figure 19. Print Pull-Down Menu

D. HELP

I On-line help is available for each item on the menu bar. An example of the
use of the Help menu option File is shown in Figure 20.
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3 Figure 20. Example of a Help Screen
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Electronic Industries Association, "DoD Digital Data Processing Study: A Ten Year 3
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The 1980 and 1985 reports by the Electronic Industries Association (EIA)
have estimates for hardware and software for both Information Technology
(management information system-like) and MCCR or embedded systems. EIA's
1990 report is strictly for Information Technology. We extracted a software-only I
estimate from these sources. The 1992 current dollar estimate for Information
Technology alone is $9.1 billion (from EIA's 1990 report), and the MCCR alone is I
$29 billion (from EIA's 1985 report).

Development/Maintenance U
Boehm, B. W., "Economic Analysis of Software Technology Investments," April 29,

1991, mimeographed briefing slides. Boehm uses a 30/o-70% development/
maintenance split. EIA's 1990 report uses a 40%-60% split.

Growth Rates

Department of Defense, "Strategy for a DoD Software Initiative," October 1, 1982. I
Pages 5-9 of the main text give a brief overview of growth rate and total
spending information. 3

Levitan, K. B., J. Salasin, T. P. Frazier, and B. N. Angier, "Final Report on the
Status of Software Obsolescence in the DoD," Institute for Defense Analyses,
Paper P-2136, August 1988. Levitan et al. offer two estimates, a 4%
productivity growth rate, and a 9% productivity growth rate.

Martin, E., 'The Context of STARS," Computer, Vol. 16, No. 13, November 1983,
p. 14-17. Estimates 12% demand growth.

Investment

Until the SWTP is officially released, the investment levels must remain 3
confidential. As a placeholder, the investment default values are set at $1 million
per year. 3
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I Inflation Indices

3 We assumed inflation of 5%.

DEVELOPMENT

End Product Cost Avoidance (Reuse)

U Fraction of Savings (FS)

Seidowitz, E., and M. Stark, "Ada in the SEL: Experience with Operational Ada
Projects," Proceedings of the Second NASA Ada Users' Symposium, SEL-89-
008, NASA/SEL, Goddard Space Flight Center, November, 1989. Siedowitz3 and Stark show that two recent NASA/SEL projects have 76% and 90%
code savings through reuse. Accompanying data suggest 30-40% savings
from code reuse, with as much as 60-70% savings for code, design, and
requirements reuse. The latter example might be representative of the reuse
savings available in a domain-specific software architechture.

Fraction of Time (FM)

3 Boehm, B. W., Software Engineering Economics, Englewood, NJ: Prentice Hall, 1981.

Process Cost Avoidance (Process)

Fraction of Savings (FS)

3 Boehm, B. W., Software Engineering Economics, Englewood, NJ: Prentice Hall, 1981.

3 Fraction of Time (F)

Humphrey, W. S., D. H. Kitson, and T. C. Kasse, "The State of Software
Engineering Practice: A Preliminary Report," CMU/SEI-89-TR-1 or ESD-

TR-89-01, Software Engineering Institute, February 1989. Humphrey et al.
report that the percentage of firms at level 3 is 5%. This is assumed to rise to3 10% in 1992, and grow to 50% by 2004.

3 Process Cost Reduction (SEEs)

Boehm, B. W., Software Engineering Economics, Englewood, NJ: Prentice Hall, 1981.

3 Another report ("Case Studies of Projects Using the Rational

Software/Hardware Products," mimeograph, 1990) suggests that 50% cost savings is

possible. Actual values for both FT and FS are based on Boehm (1991).
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Boehm, B. W., Software Engineering Economics, Englewood, NJ: Prentice Hall, 1981.
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ABBREVIATIONSI
COTS commercial off-the-shelf

3 DARPA Defense Advanced Research Projects Agency

DoD Department of Defense

EPCA End Product Cost Avoidance

FS fraction of savings

FT fraction of time

3 IDA Institute for Defense Analyses

MCCR mission critical computer resources

I NPV net present value

3 OMB Office of Managment and Budget

PCA Process Cost Avoidance

PCR Process Cost Reduction

RCF residual cost fraction

ROI return on investment

I SEE Software Engineering Environment

SEI Software Engineering Institute

3 STARS Software Technology for Adaptable, Reliable Systems

SWTP Software Technology Plan

I

I

Abb-1


